
SIMULATION OF ROCK FALLS 
 
Rockfall is software which simulates the fall of rock fragments down a slope. The 
analysis is performed in 2 dimensions and the fragments of the rock are considered as 
single particles with planar movement which is described by linear components. 
The software has a Graphical User Interface and is programmed in Microsoft Visual 
C ++ 5.   
 After double-clicking on the rockfall.exe, the following picture appears. 
 

 
 
 
The user can also maximize the application window, so that the full screen is 
available for viewing the model.  
 
The program operates as a typical Windows program. It has Toolbar Options (File, 
View, Run, and Help) and in the main screen we can see the cross section of the slope 
and the fall of the rock fragments. 
 
In order to execute the program the following conditions should be satisfied: 
In the directory \WINDOWS\System the user must install the file mfc42.dll, which is 
usually already there (by the installation of some other program). In the case where 
this file does not exist, the user can download it (http://www.microsoft.com).  
Moreover, in the international adjustments of the Windows control panel, the list 
separator must be defined as the Greek question mark.  
 
 
 
 
 
 
 
 
 
 
 

http://www.microsoft.com/


INPUT DATA 
 
In order to define the input data, a Text file must be used. For example, with the help 
of a text editor like the Windows Notepad, (Start->Programs->Accessories-
>Notepad).  
The input data must be saved as a PCF file, for example data1.rcf. 
 
The structure of the Input Data must be as follows: 
 
-number of points- 
  x y kn ks f 
  x y kn ks f 
   …. 
 
For example: 
7 
0.0 0.0 0.4 0.8 0.35 
6.0 -15.32 0.4 0.8 0.2 
14.0 -16.00 0.4 0.8 0.35 
26.0 -17.3 0.4 0.8 0.3 
50.0 -29.3 0.4 0.8 0.32 
70.0 -53.2 0.4 0.8 0.35 
90.0 -12.0 0.4 0.8 0.35 
 
This example describes a polygon slope of 7 points. 

• The first row shows the number of the points. This number must be integer (in 
this case 7).  

• The other rows describe the points and their attributes. The number of these 
rows is equal to the number of the points which define the slope (7).The 
values in each row are separated from each other with a simple space, while in 
order to change from one row to another, the user must press the enter key.  

• The values which correspond to “x” must increase as we move downwards to 
the table. In general, the analysis is performed with the consideration that the 
rock fragments move with direction to the right.  

• The coefficient kn is the coefficient of damping towards the normal direction 
(elastic impact: kn=1, complete energy dissipation:kn = 0). 

• The ks coefficient is the coefficient of damping towards the tangent direction. 
• The coefficient f is the friction coefficient and should be selected according to 

whether sliding or scrolling occurs. 
 
 
 These properties concern the side of the poly-line which begins from the current 
point. The attributes of the first point concern the first side while the attributes of the 
last point don’t have any participation.  
 
 
 
 
 
 



The user must save these values in the form of a   .rcf file (e.g. rock1.rcf) and can be 
recalled through the command File-> Import RCF. 
 

 
 

 
 
 
 
 

 
 



 
 The user can change the appearance of the slope with the command View->View 
Options, or by pressing the key F3. 

 
 Through this Dialog Window it is feasible to Zoom in or Zoom out. Moreover, it is 
possible to change the center point of the representation 
 
EXECUTION OF THE SIMULATION 
  
The simulation can be performed by using the 2 following methods: 
 

• Simple Simulation ( Simple Simulation) 
• Multiple Simulation ( Multiple Run), mainly for statistical analysis 

 
The user can choose the simulation method through the Run menu. 

  
By clicking the key F8 or Options in the Toolbar Menu appears the following 
Window: 

  
These are the Simulation Adjustments. 

• Ux and Uy describe the initial velocity of the rock fragment in the case of the 
Simple Simulation (m/sec). 

•  Umin is the minimum velocity of the rock fragment.  



 
If the velocity of the rock fragment is smaller than Umin, the bouncing ends and 
the slide or the scrolling begins. The execution of the simulation ends when the 
velocity of the rock fragment becomes smaller than Umin that is when there is a 
situation of slide or scrolling and when the friction coefficient is larger than the 
inclination of the slope.  
• Gravity is the acceleration of gravity (m/sec2) and 
•  dt is the calculation step with recommended values smaller than 0.1 sec.  
 
 
By clicking in one of the 3 choices of the Run Style, the graphical output of the 
simulation between the trace of the rock fragments, the in motion rock fragments 
or the line, change. 

 
By clicking Run-> Run Once or by pressing the key F5, the user chooses to execute 
Simple Simulation. 
 

 
 
 
 

In this graphical output we can see the maximum distance that the rock 
fragment reaches, the distance where the rock fragments finish, and the real time of 
the rock fall. By changing the step dt, it is possible to achieve simulation in “real 
time”. 



In order to terminate the simulation, the user must choose from the run menu, 
Run->Halt Run Operations or by pressing the key F7. 

 
The Statistical Analysis is feasible by using Multiple Run (Menu->Multiple 

Run) or by pressing the key F4. 
 
 

  
 

• ux_min , ux_max is the range of the  initial velocity ( m/sec) 
• b_min, b_max is the range of the initial shot angles  (degrees) 
• There are executed steps2 ( for example: 10steps-> 100 simulations) 
• The “stats on Xsection” is the position (X) in which the statistics are 

taken into account for the heigth and the velocity of the rock 
fragments.When “Write Stats” is on, the statistical is exported in an 
.xls file. By executing the simulation, appear 100 successive cases of 
falls for the rock fragment. 

 

  
 
 



And if we the user has selected to export an xls file (Write Stats.), the 
following Window appears: 

 
 
The exported file is a CSV file. By opening the file which was created in 
Excel, appears the following image: 
 

 
 
 
 
 
 
 
 
 
 
 



These results can be used and with the help of the Excel the user can have 
charts: 

 
 
 
 
 
 
OTHER FUNCTIONS 
 
 
From the File menu the user can save a model (Save, Save as.), recall a 
model (Open), create a new file (New), print (Print) and terminate the 
program (Exit) 
 

 
 
 
 
 
 
 
 
 
 
 



BRIEF DISCRIPTION OF THE ALGORITHM- THEORETICAL BASE 
 
 
The simulation situation is described by the following parameters : 

• Time t  
• Function situation: 

1: movement in air 
2: movement in ground 
0: finish of the simulation 

• Vector of the position [ x,y]T 
• Vector of the velocity [ ux , uy ]T 

 

 The simulation takes place with the execution of 2 loops. In every loop there are 
calculated the Vector of position and Velocity, according to the calculation step ( dt). 
Moreover it is calculated the total time ti +1= ti +δt and the function situation for the 
next step is ascribed with the excecution of the neccessary checks  

 
Movement in air: 
 
The movement in air is described with a parabolic trace. The new velocity 
is given by the following equation: 

                   
                  [ux, uy]T = [ux, uy - g δt]T

                    
                   While the new position: 
 
                   [x, y]T = [x + ux δt, y + uy δt - ½ g δt²]T

 
g: the acceleration of gravity, usually 9.81m/sec2 

                              
 
 
Impact control: 
 
After calculating the new position of the orbit in air, it is necessary to 
check the impact with the ground. 

                  Say (x1,y1), (x2,y2),...,(xi,yi),...are the points which desribe the polyline of 
the surface of the ground.A control takes place for all of the sides of the ground 
 
If xi ≤ x ≤xi+1   
Then for the side “i-i+1” the following check takes place: 
 
First of all the magnitude  y0  is calculated: 
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• If  y > y0 , then the rock fragment is still on air (situation number “1”) 
• If  y≤ y0,   then the impact has allready occurred and the current step δt is been 

recalled: 



[ux, uy]T = [ux, uy + g δt]T 

[x, y]T = [x - ux δt, y - uy δt + ½ g δt²]Τ
 
By solving the quadratic equation, the appropriate δt΄ is being calculated so that it 
will be excecuted again with step δt΄ which will cause:  
 y=y0 (the rock fragment is on the ground) 
 

At this point the tangent and the vertical components of the velocity on the ground are 
being calculated .If the inclination angle of the ground is θ, then: 
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During the impact ,a portion  of the kinetic energy is being absorbed due to the 
inelastic impact.Towards the tangent component the direction of the velocity is stable 
while the value is being reduced by a coefficient ks. When the damping coefficient is 
1, then the absorption of the kinetic energy is zero, while when the damping 
coefficient is 0, all the kinetic energy is being asorbed.Towards the vertical 
component, we have inelastic impact. The reduction of the kinetic energy is being 
calculated with the help of the kn      coefficient.The new values of the velocity are: 
 
[us’, un’]T = [ks us, -kn un]T 
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Checking the alteration of the situation: 
 
Checking the alteration of the situation, according to the vertical component of the 
velocity: 
 
If |un| > umin,  then the simulation continnues in the situation number “1” 

If  |un| < umin, then the simulaton continnues in the situation number “2”, movement in 
the ground.By placing  un = 0,  ux, uy. are being anew calculated. 
 
Movement on the ground : 
 
The movement on the ground is a linear accelarated one with resistance deu to the 
friction or due to resistance in scrolling.This is expressed by a dmentionless 
coefficient “f”. If N is the vertical reaction that the ground forces on the rock 
fragment, then the resistance in moving equals with fN. The coefficient should be 
choosed by the user according to wheather it is expected sliding or scrolling, 
according to the shape of the rock fragments, the inclination of the ground and the 
fricion coefficient in sliding. 
 



Side localization 
 
If xi ≤ x ≤xi+1  
 
Then the movement takes place on the side   “i-i+1” 

 The inclination of the side is being calculated  
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the angle:  θ = tan-1λ 
 
 
 
Termination of the simulation

If the situation is number “2”, 2 2

minx yu u u+ ≤  and the resistance coefficient is larger 

than the ground inclination :(f>|λ|), then the simulation is being terminated. 
 
Movement on the ground: 
 
The linear accelerated movement takes place according to the acceleration 
components αx, αy. 
 
αx = -g sinθ cosθ – g cosθ cosθ f <s> 
αy = -g sinθ sinθ – g cosθ sinθ f <s> 
 
The <s> coefficient equals : 
 
 1  when ux > 0 
-1  when ux < 0 
 0  when ux = 0 
 
The new value of the velocity is calculated by the following equation: 
 
[ux, uy]T = [ux + αx δt, uy + αy δt]T 
 
 
While the new position: 
 
[x, y]T = [x + ux δt + ½ αx δt², y + uy δt + ½ αy δt²]Τ 
 
 
 In some cases though, the escapement is unacceptable and therefore an additional 
check must take place concerning the direction of the old and the new ux component. 
In the case where the direction is different, then the calculations take place not by 
using δt but with, 
δt’ = -ux/αx 
 
 



Situation alteration check:  
 
This check takes place to define wheather the new x position is between the side   

 “i-i+1” or not: 

xi ≤x ≤ xi+1 

If so, then the simulation continnues in the situation “2”. If not, then the appropriate δt 

is being calculated so that the rock fall will be within this limit.  

And the situation changes to 1 so as in the next loop to implement movement in the 
air, or impact according to the ground’s morphology.   
 
 
 
Additional termination checks: 
 
In the case where the rock fragment finds itself beyond the ground limits, then the 
simlation is being terminated. 
In the case where the total simulation time exceeds t=40 sec then the simulation is 
being terminated. 
Finally, in the case where the rock fragments move on the ground, in cavity with a 
shape like a V, then the simulation is being terminated in order to avoid the creation 
of an interminable loop.  
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